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Overview

The SOA Gateway software consists of two components:

■ The Adabas SOA Gateway Server component, running on the target platform local to your
ADABAS database

■ The Adabas SOA Gateway Control Centre component used for configuration and monitoring,
which must be installed on a Windows or Linux platform, as preferred by the user

SOA Gateway Control Centre prerequisites

■ On Linux, the GTK2 Windowing system and its dependencies.
■ A Java Runtime Environment (minimum: JRE 1.6)

SOA Gateway Server Operating System Prerequisites

SOA Gateway is currently supported on the following platforms:

■ Windows XP Professional
■ Windows 7

Important: All Windows 64-bit platforms are supported by running the SOA Gateway in
32-bit compatibility mode.

■ Linux x86 (32-bit)
■ Linux x86 (64-bit)
■ Linux s390x (64-bit)
■ AIX 5.3 / 6.1 (64-bit)
■ Solaris 9/10 SPARC (64-bit)
■ HP-UX 11i v2 Itanium (64-bit)
■ z/OS
■ z/VSE
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z/OS

A userid and password that can be used on the z/OS system.

Appropriate RACF/ACF2/TOP-SECRET access to create datasets.

SOAGateway installation requires that server files be sent to the z/OS host, therefore an accessible
ftp server must be running on this host.

A free TCP/IP port that can be used (One per SOA Gateway)

The ability to add a started task or submit a long running job.

Adabas databases accessed via SOA Gateway must be UES-enabled.

The Adabas WAL813.L003 as well as WAL813.LOAD (or above) libraries must be in the STEPLIB
chain, otherwise no access to Adabas will be possible from the SOA Gateway server.

Under certain circumstances, the Adabas link routines may not pick up the SVC and DBID values
specified via DDCARD. In this case the SVC number and Database Id must be zapped into
ADALNKR, as described in the Adabas installation documentation, and themodifiedADALNKR
made available in a STEPLIB library ahead of the one containing the original, unzapped version.

Windows

Microsoft Visual C++ 2005 Libraries. The redistributable can be downloaded here

Microsoft Visual C++ 2008 Libraries. The redistributable can be downloaded here

It is strongly recommended that you restart Windows after this installing this redistributable.

Linux

The SOAGateway installation requires that server files be sent to the target machine, therefore an
accessible ftp or SSH server must be running on the target machine.

Solaris

The SOAGateway installation requires that server files be sent to the target machine, therefore an
accessible ftp or SSH server must be running on the target machine.

3Server and Control Centre Installation
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AIX

The installation files require the "tar" and "gunzip" programs to be extracted.

The SOA Gateway installation scripts require the bash shell.

At least 100MB of free disk space

A minimum level of Adabas v5.1.

The SOAGateway installation requires that server files be sent to the target machine, therefore an
accessible ftp or SSH server must be running on the target machine.

Additional Software Prerequisites

SOA Gateway requires the following software versions

■ Minimum Adabas v5 on OpenSystems platforms (Windows / Linux / Unix); Adabas 6.1.3 +
Adabas Client (ACL) 6.2.1.8 required for LOBs (large objects) access

■ Any supported UES-enabled Adabas version on the mainframe (v7.4 and higher); Adabas 8.1
or higher required for LOB access

■ iTrac ADAOS-3371 must be applied
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This document contains general information which applies when installing and setting up any
Software AG product on a UNIX platform. The following topics are covered:

General Information

Installation Package

The installation package containing Software AG products is provided on a CD-ROM conforming
to the ISO 9660 standard.

TheCD-ROMcontains a complete directory structurewhich clearly specifies product and platform.

Software AG Environment

The following figure shows the general directory structure generated during installation and the
environment variables which reference the specified directories:

The environment variable $SAGdefines the root directory for all SoftwareAGproducts. It is recom-
mended to define SAG=/opt/softwareag.

Note: If you want to use applications with S-bit, which call Adabas, it is required to define
SAG=/opt/softwareag.

Server and Control Centre Installation6
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For each product, the variable $prodDIR is set to the path of the main directory of the product
specified, where prod is a three-letter product code in upper-case letters. For example, all files for
Natural, whose product code is NAT, are contained in the directory $NATDIR.

However, there are exceptions to this convention. For example, the product code for Predict is
“PRD” but the environment variables use the prefix “DIC” instead.

The name of the main directory is usually the same as the product code in lower-case letters. For
example, the main directory for Natural is named nat.

Version-independent parts of the product, such as examples or data, are stored in a subdirectory
of the product main directory.

Version-dependent components of the product are kept in the version directory
$prodDIR/$prodVERS. For example, the current version of Natural is stored in the directory
$NATDIR/$NATVERS.

The environment variables prodDIR and prodVERS for all products specified during installation
are defined in the file sagenv.new. The same applies for any other environment variables needed
for the various products.

Multiple $SAG Environments on the same Machine

If you want to install more than one $SAG environment in parallel on the same machine, you
should consider the following points:

■ In this case, no $SAGmust be set to /opt/softwareag.
■ /opt/softwareagmust not be defined as a link to one of the $SAG.
■ It is not possible to use applications with S-bit, which call Adabas.
■ The $SAG environments are not completely independent, in particular, it is not possible to start
Adabas databases with the same database ID from different $SAG environments in parallel.

Before Installing your Software AG Product

It is recommended that you use /opt/softwareag as one common root directory for all of your Software
AG products. For Linux systems, this location is the registered name with LANANA.

The default search path for dependent libraries of some Software AG products is /opt/softwareag.
They are loaded from this location or using the environment variable $LD_LIBRARY_PATH
($SHLIB_PATH on HP-UX systems). If you install the product to a different location (for example,
/usr/SAG instead of /opt/softwareag), you may create a symbolic link to your $SAG directory to get
a valid default search path:
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su
cd /opt
ln -s $SAG softwareag

The following activities must be performed if you are installing a Software AG product for the
first time, or if your environment is not yet set correctly due to any other causes.

This section covers the following topics:

■ Creating the Administrator's Account and Group
■ Backing Up Your Current Product Version
■ Logging in as User "sag"

Creating the Administrator's Account and Group

You must create one administrator account and one group for all Software AG products when
you install your first Software AG product.

1. Define an administrator account to which all of the Software AG products installed at your site
belong. Since all environment definition files for the products arewritten in Bourne shell syntax,
the Bourne (or Korn) shell is recommended as the login shell for the administrator account.
This section assumes that the administrator account is called "sag".

2. Define a group to which the administrator belongs. This section assumes that this group is also
called "sag".

3. Create a login directory for the user "sag".

4. Add the group "sag" in the system file /etc/group and the user "sag" in the system file /etc/passwd.

Note: To perform these steps, use an appropriate system administration tool.

Backing Up Your Current Product Version

When upgrading a product, it is strongly recommended that you back up your current product
version.

Logging in as User "sag"

This description assumes that the user "sag" is the administrator for Software AG products. Log
in as the user "sag" (it is not recommended to log in as "root").
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Installing the Contents of the CD-ROM to Disk

Before performing the following steps,make sure that the administrator user and group have been
created and defined.

To install the contents of the CD-ROM to disk

1 Load the CD-ROM in the CD-ROM drive and mount it if this is not done automatically.

DescriptionCommand

To mount a CD-ROM
you may need to be
root.

su - root

You may need to
create a mount
directory for the
CD-ROM.

mkdir /mount-dir

Execute the mount
command (see the

mount platform-specific_mount_options device-name /mount-dir

table below for
operating
system-specificmount
commands).

Return to "sag" user.exit

Platform-specific mount command and options to mount the CD-ROM as ISO9660 or High-
Sierra file system:

Mount CommandPlatform

/usr/sbin/mount -F cdfs -o cdcase device-name /mount-dirAIX

/usr/sbin/mount -F cdfs -o cdcase device-name /mount-dirHP-UX

/usr/sbin/mount -F hsfs -o ro device-name /mount-dirSolaris

/bin/mount -t iso9660 -o ro device-name /mount-dirLinux (IA-32)

Note: On Solaris, the volume management daemon voldmight be active. This daemon
mounts the CD-ROM automatically.

Example for Linux:
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/bin/mount -t iso9660 -o ro /dev/cdrom/mnt

2 Check the directory structure of the UNIX part of the CD-ROM. When you run an ls(1)
command on the CD-ROM, you will see a structure like the following:

Note: Depending on themount options used, the files will be all upper case or all lower
case. If you mount the CD-ROM as a pure ISO 9660 Interchange Level I CD, you will
also see a version number ;1 appended to all files. Please note this for the following
steps and use the correct name format.

3 For Linux S/390 the file ASGv231n.tgz is provided for your convenience. The following steps
can be performed after you have loaded the CD-ROM on a Windows or UNIX machine that
has a network connection to the Linux S/390 system:

1. Copy the fileASGv231n.tgz that is located in the root directory of the CD-ROM to a tempor-
ary area such as /tmp/cdrom in your Linux S/390 environment, using for example ftp in
binary mode.

2. Unpack the tgz file using the command tar -xzvf ASGv231n.tgz, where n is the number
of the patch level.

3. Read the installation instructions for details on how to start the installation from thismedia
in the file setup.txt in this directory. Instructions of how to proceed after installing the
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software will be displayed at the end of the installation and also copied onto your hard
disk.

4 Please continue reading the step-by-step installation instructions for the Software AGproduct
being installed.

11Server and Control Centre Installation

Installing and Setting Up Software AG Products under UNIX



12



3 Installing the SOA Gateway Control Centre

■ Prerequisites .................................................................................................................................. 14
■ Download and install Eclipse ............................................................................................................. 14
■ Install required additional Features/Plugins ........................................................................................... 15
■ Install the SOA Gateway Control Centre .............................................................................................. 15
■ Install the Control Centre from a product CD ......................................................................................... 16
■ Install the SOA Gateway Control Centre from an Update Site ................................................................... 17
■ Next Steps ..................................................................................................................................... 43

13



Prerequisites

Java is required to run the Eclipse SDK

If you already have Java Runtime Environment (JRE, v1.6 or higher) installed, youmay skip this step.

To find out what level of java you have installed, run the command java -version from either a
shell ( Unix/Linux) or command box (Windows) depending on your system.

If Java is not installed already in your environment, follow these steps

■ Install the latest version from here.
■ The minimum version, JRE 1.6 is available here
■ Find the "Java Runtime Environment (JRE)" and download it.
■ Accept the license agreement, and choose the correct package for your platform.
■ Start the Java installer (for example double-click) and follow the instructions.

The Java download site provides detailed install instructions.
■ Once the installer has finished, Java is installed in your environment.

Download and install Eclipse

The Eclipse OpenSource framework forms the base for the SOA Gateway administration and
monitoring tool, the 'Control Centre'.

Eclipse 3.6 (or higher) is required to run the SOA Gateway Control Centre. If you have a valid
copy of Eclipse installed already, you may skip this step.

Steps required to install the Eclipse framework:

1. Download Eclipse version 3.6 for your environment :

forWindows x86

forWindows x86-64

for Linux x86 GTK2

for Linux x86-64 GTK2

kits for other environments are available here, select the one matching your environment.
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2. Unzip the downloadedpackages, thiswill create a directory structure under a top-level directory
named 'eclipse', at the selected file system location. for example C:\eclipse on Windows when
unzipping into C:\, or /user/eclipse on Unix/Linux if the selected location was /user

3. Start Eclipse - 'eclipse.exe' on Windows, './eclipse' on Unix/Linux, from the top-level eclipse
directory.

If you are new to Eclipse, please take the 'Getting started with Eclipse' tour before continuing.

Install required additional Features/Plugins

To run the SOA Gateway Control Centre, you must first install the following additional plugins.

Note: As the Eclipse Update Manager may need to get to an external site, you may have to
specify a HTTP proxy in order to access it from an intranet. Instructions on how to set the
HTTP proxy can be found in the Troubleshooting section.

Steps required to install:

1. Start the UpdateManager, which can be found on the Eclipse mainmenu underHelp -> Install
New Software.

2. Open theHelios from the drop down box.

3. Select the following feature
■ Web, XML and Java EE Development

ClickNext

4. A list of selected features will be presented, selectNext to continue.

5. If you agree with the feature licences, select "I accept ..." radio button and click Finish to
download and install the features.

6. When prompted, restart eclipse.

Install the SOA Gateway Control Centre

The SOA Gateway Control Centre is installed into the Eclipse environment with the "Update
Manager" aswell. Start Eclipse and follow these steps to download the installation files, depending
on the installation source:

■ Install from a product CD
■ Install from an update site

15Server and Control Centre Installation
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Install the Control Centre from a product CD

■ Start theUpdateManager,which can be found on the EclipsemainmenuunderHelp -> Software
Updates.

■ Select 'Add ...'
■ Click Archive...

In the file chooser dialog, navigate to the location of the archived update site on the CD, in the
eclipse/updates folder.

Important: The name of the Archived Update Site zip file may be different to this example
as it may change from version to version, the current zip file will always be located in ec-
lipse/updates, so please navigate to that location and pick the zip file present there.

ClickOK
■ The Update Manager will now show the contents of the archive.

You should always select the SOA Gateway Control Centre catagory

Important: To be able to deploy server(s) later on select all required server install kit(s)
here as well
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Important: Depending on the SOA Gateway version on your CD, the version numbers
above may not match exactly.

■ Click Install

A list of selected features will be presented for review, confirm by clicking the Finish button
■ You will be prompted to restart Eclipse.

Click Yes
■ After Eclipse has been restarted, the SOA Gateway Perspective will be activated automatically,
and you are asked for the name of the initial project in the selected workspace.

SelectContinue to start the deploymentwizard and begin deploying your SOAGateway Server
now.

Select Later to create the intial project, and deploy SOA Gateway Server files later on.

Proceed to the Server Installation section.

Install the SOA Gateway Control Centre from an Update Site

■ Start the Update Manager, which can be found on the Eclipse main menu underHelp -> Install
new software.

Note: As the Eclipse Update Manager may need to get to an external site, you may have
to specify a HTTP proxy in order to access it from an intranet. Instructions on how to set
the HTTP proxy can be found in the Troubleshooting section.

■ In theWork with text box, enter the URL

http://developer.softwareag.com/tech/eclipse/updates/site.xml. You will need an Empower account in
order to be able to do this.

■ TheUpdateManagerwill now contact the update site and display the list of available downloads.
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■ An empty box next to the features name indicates that the feature is not selected
■ Choose a feature by clicking the checkbox beside it. A tick appears in the box beside the features
■ You should always select the 'SOA Gateway Control Centre' catagory
■ You should also select the install kit(s) which correspond to the system that will run the SOA
Gateway Server

■ In some cases, you may also drill down by expanding the feature menu.
■ Once finished, clickNext and the required features will be downloaded.

■ Depending on the amount of features selected, and the speed of your connection, this may take
some time.

■ Once the download has finished, you will be presented withe Legal Notices dialog. Read and
Accept the license agreement before continuing.

Check I accept the terms in the license agreement and clickNext

■ Review the features to be installed, and click Finish

■ The selected features will now be installed.
■ If the features have been signed, youwill be asked if youwant to install a digitally signed feature.

Either way, clickOK

■ Restart Eclipse when prompted.
■ After Eclipse has been restarted, the SOA Gateway Perspective will be activated automatically,
and you are asked for the name of the initial project in the selected workspace.

SelectContinue to start the deploymentwizard and begin deploying your SOAGateway Server
now.

Select Later to create the intial project, and deploy SOA Gateway Server files later on.

Next Steps

Now the SOAGatewayControl Centre has been installed. Proceed to the relevant server installation
section choosing a link below.

Server Installation Procedure - Windows

Server Installation Procedure - z/OS
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Server Installation Procedure - All other platforms
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Important: The information here is forminor updates, e.g. hotfixes, patches, etc. For all major
updates (e.g new software release), SOA Gateway should be installed anew, and existing
services should be copied using the Control Centre. See here for more details.

The followingwill guide you through the process of updating your existing SOAGatewayControl
Centre and Server.

The SOA Gateway updates are provided via an Eclipse wizard. When you update your Control
Centre (the "Base" feature), the updates are applied after the Find and Install process has finished,
and the Eclipse IDE restarts.

Your SOA Gateway server will not be updated until you re-deploy the server.

Using the Eclipse Wizard to find and install updates

It is assumed that the SOA Gateway Control Centre has already been installed, as detailed in the
respective section of this installation guide.

This section describes how to update the Control Centre and also the server installation kit(s) to
a level higher than the one currently installed

Eclipse checks a list of available software sites for updates. These sites can be configured by selecting
Window -> Preferences -> Install Update -> Available Software Sites.

The SOA Gateway entry in this list needs to be checked for updates to function correctly.

Ask Eclipse to check for updates by selecting Help -> Check for Updates. All currently installed
features will be checked.

If you wish to install additional server kits for deployment, use Help -> Install New Software.

If newer versions are found, they will be downloaded and you will be asked to restart eclipse.

Update Server - Windows

If you followed the steps above, you now have successfully updated your Control Centre, and
have downloaded the updated server installation files.

Important: The SOAGateway Server has not been changed at this stage. You need to re-deploy
to update the server.
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You must uninstall your existing SOA Gateway Server before continuing. The uninstall process
will not uninstall your existing dataviews and schemas. You may want to make a backup of your
existing configuration, and restore it once the new installation is complete.

■ Make a backup of %ALLUSERSPROFILE%\Software AG\Adabas SOAGateway 2.6.1\config-
uration\sampleConfig-win.xml ,%ALLUSERSPROFILE%\SoftwareAG\Adabas SOAGateway
2.6.1\configuration\asg26.xml and C:\Program Files (x86)\Software AG\SOA Gateway
2.6.1\Apache22\conf

Follow the instructions here to uninstall SOA Gateway

Now restart the SOA Gateway deployment wizard, and follow the normal server installation
process. See here for more details

Restore your configuration by putting back the previously saved sampleConfig-win.xml and ht-
tpd.conf

Stop and start SOA Gateway, and this completes the update.

Update Server - non-Windows Platforms

If you followed the steps above, you now have successfully updated your Control Centre, and
have downloaded the updated server installation files.

Important: The SOAGateway Server has not been changed at this stage. You need to re-deploy
to update the server.

z/OS Update

You can run a new SOA Gateway server side-by-side with the existing server, so long as the
datasets names and the port that the server listens on are different.

Alternatively, you can re-deploy a new server, and simply use the new LOAD library in the
STEPLIB of your existing installation.

Follow the instructions here to deploy the updated server.

Important: Ensure you choose new dataset names.

Follow the instructions here to copy web services between servers.

*nix Platforms

You can run a new SOA Gateway server side-by-side with the existing server, so long as the in-
stallation location and server port are different.
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Alternatively, you can transfer the updated installation files, and provide the -update option when
starting the installServer.sh script.

Follow the instructions here.

Important: If you want to create a new installation, ensure you choose a new installation
directory, and a server port different from the existing.

Follow the instructions here to copy web services between servers.

If you have updated an existing installation, then the update is now complete.
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The following will guide you through the process of installing and starting the SOA Gateway
server.

Using the Deployment Wizard for Linux/Unix type systems

Once the SOA Gateway Control Centre has been installed, you are ready to download the SOA
Gateway Server install files to your local machine.

The next step then is to install and start the SOA Gateway server. To do this, you may have to
deploy files to a remotemachine. For example, youwant to run your SOAGatewayControl Centre
on Windows, but your SOA Gateway server on Linux. You can use the deployment wizard to
send the deploy the required files to Linux and start your server.

■ If this is the first time you've started the Control Centre, the SOA Gateway Perspective will be
activated automatically.

If, for some reason, the SOAGateway Control Centre perspective has not started, clickWindow
-> Open Perspective -> Other and choose SOAGateway Control Center (Admin) from the list.
ClickOK

You will be asked to specify a project name or accept the default. Usually you will now simply
click the 'Continue' button, whichwill then start the 'DeploymentWizard' to guide you through
the process of defining your server within the SOA Gateway Control Center and transfer (FTP)
the installation files to the SOA Gateway Server target machine.

■ If you, for whatever reason, opt to NOT run the Deployment Wizard at that time, you can start
thewizard anytime later on by clicking the Deployment action button in the title bar of the 'SOA
Gateway Servers' view

■ The Deployment Wizard will now start
■ From the drop-down menu, choose the installation files you want to deploy. These files were
downloaded as part of the Find and Install step above.

■ Select your SOA Gateway license file.
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■ In this example we are deploying to a x86 Suse Linux 10 machine, so select the relevant install
kit from those listed as being covered by the selected license. The license information is also
displayed.

■ ClickNext
■ The following screen allows you to either select an existing SOA Gateway server to deploy to
(a list of servers known within your Control Centre environment is presented), or to define a
new SOAGateway server to the Control Centre. This server definition will be used for both the
deployment process as well for (remote) server administration later on.

■ To define a new server:

1. Enter a 'friendly name'. This name will be used to refer to a SOA Gateway Server without
needing to enter the hostname (or IP) later on.

2. Enter the hostname or IP of the machine on which the SOA Gateway server will run. This
host/IP will be used to send the install files ( via FTP ) and will become the host/IP that you
use when issusing requests to SOA Gateway.

3. Enter the port which you would like SOA Gateway to listen for connections on.

A new Apache web server will be installed, you must ensure that the port choosen here is
available for use on the server machine.

The port entered here will utimately be the port that SOA Gateway uses to service requests.

4. Important: Once you have filled in all of the above, click 'Add Server'

5. The server will now be added to your SOA Gateway Control Centre 'Servers View' for later
use.

■ Alternatively, if an already defined server is to be used (i.e. installation files deployed to it),
check 'Deploy to existing SOA Gateway Server' and select a server from the list in the 'Existing
Server Information' section.

■ Select the transport mechanism, one of
■ FTP: only transfer, actual installation has to be carried out by logging on to the target system
and starting the installation script manually

■ SSH: this method optionally allows for automatic ("silent") installation, no separate login to
the remote system required. After the files have been transferred the install script will be ex-
ecuted by the deployment wizard, the SOA Gateway server (optionally) be started.

■ ClickNext
■ The next screen is used to deploy the installation files to the target machine, i.e. the machine is
where the SOA Gateway server will run. Which of the following paths will be taken depends
on the choice made regarding the transport mechanism above.

FTP:
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■

■ The Host / IP will have already been filled by what has been specified on the previous page.
■ Enter the username which is used to login (via FTP) to the server machine (if required)
■ Enter the password (if required)
■ Enter a directory to send the installation files to. This directory may be relative to the login
directory, or can be a fully qualified path name. The directory will be created if it does not
exist.

■ If your FTP server requires a port other than 21, you can specify that by selecting Specfic FTP
Port and entering the FTP port number.
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■ If your FTP server requires passive mode transfers, you can enable this by selecting the
Passive Mode checkbox

■ Important: Click the Start FTP button to begin the FTP.

■ The Additional parameters group will allow you to enter (if required) additional information
required for the operation of the driver(s) to be installed. Parameters related to all licensed
drivers are queried here, you may omit those for all drivers you do not intend to use.

■ Once the FTP has completed, you need to logon to the target machine, and run the server-
specific installation steps.
■ Server installation steps

SSH:

■ To just transfer the install files and not have the Deployment Wizard run the installation re-
motely, fill in your login credentials, sepcify a directory to transfer the files to and click Start
Install.
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Once you have started the transfer you will prompted for your confirmation that it is really
the host you want to send the files to.

■ If you want the Deployment Wizard to also schedule the actual installation remotely, check
the "Silent (automatic) installation" option, set the various directories, then click Start Install.

■ Important: If you do not want to do the installation silently, follow the instructions here

■ Important: If you are updating an existing installation, the "Silent (automatic) installa-
tion" should not be checked.
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WhendifferentUser IDs are specified for the "login" and "handle server requests", the following
will prompt you for confirmation, please check if the authorization level for the user running
the SOA Gateway server is sufficient to access and execute files created by the "login user".
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If the directory specified to contain the install log file does not exist youwill be asked to create
it before the installation can continue.

All other files will be created by the installation scripts.

The overall transfer status will be shown directly within the Deployment Wizard window,
for larger files an external window will pop up to indicate the progress.

■ Note: To enable "passwordless logins" execute the following steps:

1. Run the command : ssh-keygen -t dsa

e.g.

Generating
public/private dsa key pair. Enter file in which to save the key
(/home/myUser/.ssh/id_dsa): Enter passphrase (empty for no passphrase): Enter
same passphrase again: Your identification has been saved in
/home/myUser/.ssh/id_dsa. Your public key has been saved in
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/home/myUser/.ssh/id_dsa.pub. The key fingerprint is:
7d:a9:f9:44:31:c3:d8:6c:d8:c1:d0:5f:39:f8:75:79 myUser@192.168.135.51

2. Copy your public key to the remote server

e.g.

>> scp .ssh/id_dsa.pub
myUser@192.168.135.99:.ssh/ Password: id_dsa.pub 100% 600 0.6KB/s
00:00

3. Login to the remove server and add your public key to the authorized keys.

e.g.

myUser@192.168.135.51:~> ssh -l myUser
192.168.135.99 Password: Last login: Tue Sep 29 17:02:47 2009 from
v-br.vpn.risaris >> cd .ssh/ >> cat id_dsa.pub >>
authorized_keys2

■ You should now be able to login to the remote server without a password.

In the case of problems, SSH informationwill appear in /var/log/messsages or /var/log/lastlog
■ Now that the server has been installed, you can query the server status from the Deployment
Wizard.

You can choose to view this status information in the DeploymentWizard, in a browser, or both.
■ Click the Display Server Status or the Display Status in Browser Window buttons to return
the status of the server.

■ You should now click Configure Driver(s) to create SOA Gateway drivers that are enabled in
your license. If you choose to not add drivers now, they can also be created at a later stage, more
information about defining drivers can be found in the Servers View section of this document-
ation.

The "DriverWizard" will present a list of licensed drivers, and come upwith all drivers selected
and ready to be defined. You may now just click the Configure button to define all of them, or
deselect those you do not need or want to set up at that stage.

Click "Configure".

In case the driver does not require any additional parameters to be set, it will be defined now,
otherwise the Driver Definition Dialog will ask for the additional parameter(s) to be set. e.g. for
an Adabas driver set the "ListMaxRecords" parameter. Click the Save button.

■ ClickDone to close the Deployment Wizard
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■ Configure SOA Gateway using the SOA Gateway (Eclipse) Control Centre

Server Installation

This section outlines machine specific installation steps.

Host-type: Linux / *ix type

1. On the target machine, in the installation directory, execute the script ./installServer.sh.

Important: This script should run using the root or sag user.

Important: If you wish to update an existing installation, run this script with the -update
option.

2. The script will check if the prerequisites are met.

3. Enter the full path of the SOA Gateway installation. Example: /opt/softwareag/soaGateway

4. If required, specify the Software AG sagenv file that is to be used (an absolute path must be
used). Example: /opt/softwareag/sagenv.new

Note: If you do not have a sagenv file available, enter skip.

5. The next prompt asks what user SOA Gateway should be started as. If you included a valid
SAGENVfile in the previous step, you should choose the userwho runs Software AGproducts,
normally the "sag" user. Otherwise, if you started the script as root, lesser privileged user will
be chosen, normally www or nobody. If you did not start the script as root, the current user
will be chosen.

6. The script now has all the information to commence the installation. Follow the on-screen in-
structions to start Apache.
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6 Installation verification

■ SOA Gateway Server installation verification ......................................................................................... 36
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SOA Gateway Server installation verification

To test if the SOAGateway Server has comeup correctly, youmay issue, from a browser, the request

http://<server>:<port>/SoaGatewayStatus

Or, on Windows, you can select Start -> All Programs -> SOA Gateway v2.4.2 -> SOA Gateway
Status

The Server should report its status. If it does not, see the Troubleshooting section.

After you have defined an accessible Resource, for example by pointing the installation supplied
"Employees" Resource to an actual Database id / File number of an Adabas "Employees" demo
file, issue the following request:

http://<server>:<port>/adabas_Employees?LIST&name=MEYER

which will, if set up correctly, display a list of employees with last name "MEYER" like this:

<?xml version="1.0" encoding="UTF-8"
standalone="no" ?> <adabasEmployees> <adabasEmployee>
<personnel_id>11600322</personnel_id>
<first_name>MARIANNE</first_name>
<middle_name>AGNES</middle_name> <name>MEYER</name>
<mar_stat>M</mar_stat>
<sex>F</sex><city>BREMEN</city>
<zip>2800</zip><country>D</country>
<area_code>0421</area_code> <phone>290755</phone>
<dept>SALE46</dept> <job_title>KASSIERERIN</job_title>
<leave_due>31</leave_due> <leave_taken>01</leave_taken>
</adabasEmployee> <adabasEmployee>
<personnel_id>20009200</personnel_id>
<first_name>LESLIE</first_name>
<middle_name>HENRY</middle_name> <name>MEYER</name>
<mar_stat>M</mar_stat> <sex>M</sex>
<city>SEATTLE</city> <zip>98105</zip>
<country>USA</country> <area_code>206</area_code>
<phone>147-4864</phone> <dept>MGMT30</dept>
<job_title>MANAGER</job_title>
<leave_due>12</leave_due> <leave_taken>08</leave_taken>
</adabasEmployee> <adabasEmployee>
<personnel_id>20023800</personnel_id>
<first_name>ARTHUR</first_name>
<middle_name>JOHN</middle_name> <name>MEYER</name>
<mar_stat>M</mar_stat> <sex>M</sex>
<city>STILLWATER</city> <zip>74074</zip>
<country>USA</country> <area_code>405</area_code>
<phone>724-8063</phone> <dept>MGMT30</dept>

Server and Control Centre Installation36

Installation verification



<job_title>MANAGER</job_title>
<leave_due>38</leave_due> <leave_taken>05</leave_taken>
</adabasEmployee> <adabasEmployee>
<personnel_id>20027900</personnel_id>
<first_name>DANIEL</first_name>
<middle_name></middle_name> <name>MEYER</name>
<mar_stat>D</mar_stat> <sex>M</sex>
<city>DENVER</city> <zip>80210</zip>
<country>USA</country> <area_code>303</area_code>
<phone>242-1213</phone> <dept>TECH05</dept>
<job_title>MANAGER</job_title>
<leave_due>19</leave_due> <leave_taken>06</leave_taken>
</adabasEmployee> </adabasEmployees>
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Introduction

This section outlines how to install the SOA Gateway Server on Windows

See here for installation troubleshooting hints.

Important: If the version you are installing is not SOAGateway v2.4.2, then your installation
may display a different version number from the screenshots below. There is no functional
installation difference between versions, so this can be safely ignored.

Installation using the Deployment Wizard

OnWindows, the SOAGateway install is done via theDeploymentWizard. This is awizardwhich
runs within Eclipse, and guides you through the steps required to install and configure your SOA
Gateway server.

■ A dialog will be presented the first time the SOA Gateway Control Center is started after its
installation. Specify a project name and click Continue

■ To start the deployment wizard at any time, click the following button

The Deployment Wizard will appear
■ Click "Browse" to select your license, choose your (Windows) installation kit from the list of
available and licensed kits.

Important: This license should reside on a local HDD (Hard Disk Drive), and not on a
network drive or SSD (Solid State Drive).
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ClickNext
■ The following screen allows you to either select an existing SOA Gateway server to deploy to,
or to define a new SOA Gateway server to the Control Center. This server definition will be
used for server administration later on.

For Windows, you should

1. Enter a 'friendly name'. This name will be used to refer to a SOA Gateway Server without
needing to enter the hostname (or IP) later on.

41Server and Control Centre Installation

Server and Control Center on Windows



2. Enter the hostname or IP of the machine on which the SOA Gateway server will run. This
host/IP will be the machine you are currently working on. In many cases, entering localhost
will suffice.

3. Enter the port which you would like SOA Gateway to listen for requests on. A new Apache
web server will be installed, you must ensure that the port choosen here is available for use
and not blocked by a firewall. The port entered here will utimately be the port that SOA
Gateway uses to service requests.

Important: Once you have filled in all of the above, click 'Add Server'
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The server will now be added to your SOAGateway Control Center 'Servers View' for later use.

ClickNext
■ Now the Deployment Wizard must launch the Windows installer program.

Press the Launch Setup button
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■ The deploymentwizard now starts anMSI installer to install the SOAGateway Server component
on the system.

When the first page appears, clickNext
■ If you require SOA Gateway to be installed in a non-default directory, click Browse and select
your directory. Otherwise clickNext

■ Click Install to continue
■ Please wait while SOA Gateway is installed
■ When the installation is complete, click Finish
■ Return to the Deployment Wizard, the message log will indicate either success or failure of the
setup process.

ClickNext
■ The next screen is used to verify that your SOAGateway is up and running, and then to configure
it based on your license.

1. Display Server Status: This displays this a short summary of the server status in the deploy-
ment wizard

2. Display Status in BrowserWindow:This displaysmore information about the servers status
in a browser.

3. Configure Driver(s): Allows you to automatically create drivers based on your license.
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■ You should now click Configure Driver(s) to create SOA Gateway drivers that are enabled in
your license. If you choose to not add drivers now, they can also be created at a later stage, more
information about defining drivers can be found in the Servers View section of this document-
ation.

The "DriverWizard" will present a list of licensed drivers, and come upwith all drivers selected
and ready to be defined. You may now just click the Configure button to define all of them, or
deselect those you do not need or want to set up at that stage.

Click "Configure".

In case the driver does not require any additional parameters to be set, it will be defined now,
otherwise the Driver Definition Dialog will ask for the additional parameter(s) to be set e.g. set
the "ListMaxRecords" parameter to a value of "0" (zero) for an Adabas Driver. Click the Save
button.

The Driver Wizard Dialog indicates the success of the operation
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■ ClickDone to close the Deployment Wizard

Post installation steps

Now SOA Gateway is installed - what's next?

■ New to Eclipse ? Take an Eclipse getting started tour.
■ Configure SOA Gateway using the SOA Gateway Control Center
■ Proceed directly to define Web Services using SOA Gateway.

Server and Control Centre Installation46

Server and Control Center on Windows



8 z/OS Installation Procedure

■ Using the Deployment Wizard to install on a z/OS host ........................................................................... 48
■ Server Installation ............................................................................................................................ 52

47



The following will guide you through the process of installing and starting the SOA Gateway
server.

Using the Deployment Wizard to install on a z/OS host

Once the SOA Gateway Control Centre has been installed, you are ready to download the SOA
Gateway Server install files to your local machine.

Important: If the version you are installing is not SOAGateway v2.4.2, then your installation
may display a different version number from the screenshots below. There is no functional
installation difference between versions, so this can be safely ignored.

The next step then is to install and start the SOA Gateway server. To do this, you may have to
deploy files to a remotemachine. For example, youwant to run your SOAGatewayControl Centre
onWindows, but your SOAGateway server on z/OS. You can use the deploymentwizard to deploy
the required files to z/OS and start your server.

■ If this is the first time you've started the Control Centre, the SOA Gateway Perspective will be
activated automatically.

If, for some reason, the SOAGateway Control Centre perspective has not started, clickWindow
-> Open Perspective -> Other and choose SOAGateway Control Center (Admin) from the list.
ClickOK

You will be asked to specify a project name or accept the default. Usually you will now simply
click the 'Continue' button, whichwill then start the 'DeploymentWizard' to guide you through
the process of defining your server within the SOA Gateway Control Center and transfer (FTP)
the installation files to the SOA Gateway Server target machine.

■ If you, for whatever reason, opt to NOT run the Deployment Wizard at that time, you can start
thewizard anytime later on by clicking the Deployment action button in the title bar of the 'SOA
Gateway' or 'SOA Gateway (legacy) Servers' view

■ The Deployment Wizard will now start
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■ Select your SOA Gateway license file.
■ From the list of licensed kits, select the z/OS kit.
■ ClickNext
■ The following screen allows you to either select an existing SOA Gateway server to deploy to,
or to define a new SOA Gateway server to the Control Centre. This server definition will be
used for both the deployment process as well for (remote) server administration later on.

■ To define a new server:

1. Enter a 'friendly name'. This name will be used to refer to a SOA Gateway Server without
needing to enter the hostname (or IP) later on.

2. Enter the hostname or IP of the machine on which the SOA Gateway server will run. This
host/IP will be used to send the install files ( via FTP ) and will become the host/IP that you
use when issusing requests to SOA Gateway.

3. Enter the port which you would like SOA Gateway to listen for connections on.

A new Apache web server will be installed, you must ensure that the port choosen here is
available for use on the server machine.

The port entered here will utimately be the port that SOA Gateway uses to service requests.

4. Important: Once you have filled in all of the above, click 'Add Server'

5. The server will now be added to your SOA Gateway Control Centre 'Servers View' for later
use.

■ Alternatively, if an already defined server is to be used (i.e. installation files deployed to it),
check 'Deploy to existing SOA Gateway Server' and select a server from the list in the 'Existing
Server Information' section.

■ ClickNext
■ The next screen is used to deploy the installation files to the target machine, i.e. the machine is
where the SOA Gateway server will run.
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■ The hostname / IP will have already been filled by what has been specified on the previous
page.

■ Enter the username which is used to login (via FTP) to the server machine (if required)
■ Enter the password (if required)
■ Enter a high-level qualifier to send the installation files to.

■ Important:

■ Check the Create datasets box (in the target information group) if you want the wizard to
create the necessary datasets (recommended). Otherwise, these must be already allocated.
For more information, see here

■ Installation type. In most cases, this should be left asNormal . If the datasets that are being
sent are patch datasets, you should select Patch from the drop-down menu.
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■ The Additional parameters group will allow you to enter the DSN(s) required for the operation
of the driver(s) to be installed. Parameters related to all licensed drivers are queried here, you
may omit those for all drivers you do not intend to use.

Note: Click the Help button(s) next to the DSN name input fields to view information
about each datasets purpose.

■ If your FTP server requires a port other than 21, you can specify that by selecting Specfic FTP
Port and entering the FTP port number.

■ If your FTP server requires passive mode transfers, you can enable this by selecting the Passive
Mode checkbox

■ Important: Click the Start FTP button to begin the FTP.

■ Once the FTP has completed, you need to logon to the target machine, and run the server-spe-
cific installation steps.
■ z/OS Installation Steps

■ Now that the server has been installed, you can query the server status from the deployment
wizard.

You can choose to view this status information in the DeploymentWizard, in a browser, or both.
■ Click the Display Server Status or the Display Status in Browser Window buttons to return
the status of the server.

■ You should now click Configure Driver(s) to create SOA Gateway drivers that are enabled in
your license. If you choose to not add drivers now, they can also be created at a later stage, more
information about defining drivers can be found in the Servers View section of this document-
ation.

The "DriverWizard" will present a list of licensed drivers, and come upwith all drivers selected
and ready to be defined. You may now just click the Configure button to define all of them, or
deselect those you do not need or want to set up at that stage.

Click "Configure".

In case the driver does not require any additional parameters to be set, it will be defined now,
otherwise the Driver Definition Dialog will ask for the additional parameter(s) to be set. e.g. we
set the "ListMaxRecords" parameter to a value of "0" (zero) for an Adabas driver. Click the Save
button.

■ ClickDone to close the Deployment Wizard

■ Configure SOA Gateway using the SOA Gateway (Eclipse) Control Centre
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Server Installation

This section outlines machine specific installation steps.

Host-type: z/OS

Dataset Create

Important: This step can be ignored if you chose the Create Datasets in the Deployment
Wizard. If so, continue to here

The SOA Gateway Installation on z/OS uses 4 datasets, which must be created in advance. The
datasets can be any name you wish, so long as they each use the same high-level qualifier. This
allows the user to specify one dataset name prefix in the Java wizard, and the installation is based
upon this qualifier.

The 4 datasets to create are RECV, JCL, CONF, and ZIP.

For example, if the high-level qualifier is SAG.ASG.INST001, then the following would be the
datasets that need to be created.

■ SAG.ASG.INST001.RECV
■ SAG.ASG.INST001.JCL
■ SAG.ASG.INST001.CONF
■ SAG.ASG.INST001.ZIP

The dataset attributes needed are as follows:

SIZEBLKSIZELRECLRECFMTypeName

see below312080FBSequentialRECV

312080FBPDSJCL

512508VBPDSCONF

see below1638416380VBSequentialZIP

These local files will be located in the directory where the wizard was started.

XMIT File: AdabasSOAGateway/zOS/ASG.XMIT
ZIP File: AdabasSOAGateway/zOS/asg.zip

The size attribute for the RECV and ZIP datasets to be created on the zOS should be calculated as
follows:
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RECV File: Divide the size of ASG.XMIT in bytes by 3120. Round the resultant size upwards to
the nearest integer to obtain the file size in blocks. We recommend a size of 9700 blocks.

ZIP File: Divide the size of asg.zip in bytes by 16380. Round the resultant size upwards to the
nearest integer to obtain the file size in blocks. We recommend a size of 700 blocks.

■ Enter the hostname or IP address of the z/OS system.
■ Select z/OS as the "Host type"
■ Enter the user ID
■ Enter the password
■ Enter the high-level qualifier used to create the datasets created earlier in the process.
■ If you wish to use a non-standard FTP port, click the "Specific FTP Port" checkbox and enter the
port to be used.

Sequential file containing the SOAGateway loadmodules. Thiswill be TSORECEIVEd
as part of the installation process.

RECV

A job to perform a TSO receive.SOAGINS1JCL

A job which deletes, creates, initializes, and unzips the SOAGateway file system into
the file system available to Apache in this environment. The DEL step of this job will

SOAGINS2

finish with CC=8 if the PFS dataset does not exist. Likewise, if the PFS dataset does
exist, it will be deleted by this job.

A job which copies a Apache's configuration file from a PDS member to the SOA
Gateway Environment.

SOAGINS3

A job which copies the license file the SOA Gateway Environment.SOAGINS4

A job which copies an Apache's SSLCONF configuration file from a PDS member to
the SOA Gateway Environment.

SOAGINS5

A job which copies SSL Certificate and SSL Key files from the CONF PDS to the SOA
Gateway Environment.

SOAGINS6

A job which copies a file out of the SOA Gateway Environment to a dataset on zOS.
Use only at the request of Tech Support

SOAGCOPY

PROC to be used for running all other jobs.SOAGPROC

Job which starts the SOA Gateway Server.SOAGSTRT

PROC to be used for various utilities.PFSPROC

A job which copies Apache's error_log to an OUTPUT DDCARD if a failure occurs
during SOA Gateway initialization. Once the SOA Gateway server is initialized, this
log will be written to the JES Spool.

CPLOGS

A job which lists the contents of the SOA Gateway file system.PFSLS

A DB2 CLI Initialization File. If using DB2 Driver this will need to be modified to
reflect the Sub-System ID and location name. Your DBA can provide this information.

CLIINI

File used by SOA Gateway to declare environment variablesCONFIGCONF
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A copy of the SOAGateway's Apache configuration file. This can be edited and copied
into the SOA Gateway file system using SOAGINS3.

HTCONF

Run-time configuration fileGROUP

Run-time configuration fileHOSTS

Run-time configuration filePASSWD

Run-time parameters for debugging. Only to be used at the direction of supportDXRTRACE

Adabas Run parametersDDCARD

Run-time parameters.SYSPARM

License File.ASGLIC

A Sequential zip-file containing the SOA Gateway file system.ZIP

If you do not wish to install the SOA Gateway (Eclipse) Control Centre, proceed to z/OS Server
Setup

You can either, logon to the z/OS host and setup the SOA Gateway Server, or install the client
pieces now (if selected) and run the server setup at a later time.

Submitting JCL and Starting Server

Review andmodify the following jobs prior to submitting them to reflect your installation standards
and the names of the datasets created during your installation.

1. Review and submit SOAGINS1 to TSO RECEIVE the SOA Gateway load library.

2. Review and submit SOAGINS2 to create, init, and populate the SOA Gateway file system.

3. Review and submit SOAGINS3 to copy the Apache configuration file into the SOA Gateway
filesystem.

4. Review and submit SOAGINS4 to copy the SOA Gateway license into the SOA Gateway
filesystem.

5. If using the Adabas Driver review the DDCARDmember and specify the correct Adabas SVC
number. Under certain circumstances, the Adabas link routines may not pick up the SVC and
DBID values specified via DDCARD. In this case the SVC number and Database Id must be
zapped into ADALNKR, as described in the Adabas installation documentation, and the mod-
ified ADALNKRmade available in a STEPLIB library ahead of the one containing the original,
unzapped version.

6. If using the DB2/ODBC Driver review the CLIINI member and specify the correct MVSDE-
FAULTSSID and Location name.

Refer to you DBA for this information.

7. Submit SOAGSTRT to bring up the SOA Gateway (Apache) server. The server is ready to be
used when you see the "XMiddLe ... is ready for requests" message in the XMIDCARD DD.
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Important: Restarting and stopping SOA Gateway: Due to the nature of the z/OS Apache
configuration it is not possible to restart the server with a single command. The server
must be stoppedwith "/p jobName" and started by submitting SOAGSTRT again. In this
scenario, Apache may issue a warning about the httpd.pid being overwritten. This
warning can safely be ignored.

8. If the SOAGateway Server is to be run as a started task (STC), copy SOAGSTRT to a procedure
library.

Starting Server with HTTPS

To enable HTTPS connections, a sample SSL certificate and SSL sample key have been provided.
These are for development only, and should not be used in a production environment.

1. If you wish the server to listen on a non-default HTTPS port, review ...CONF(SSLCONF) and
change all instances of 443 to the port you wish to listen for HTTPS connections.

2. Edit the ...CONF(HTCONF) member and uncomment the Include conf/extra/httpd-ssl.conf
directive

3. Ensure the server has been stopped

4. Review and submit SOAGINS5 to copy SSLCONF into the SOA Gateway file system.

5. Review and submit SOAGINS3 to copy HTCONF into the SOA Gateway file system.

6. Edit SOAGPROC and change the server parameters to -X -DSSL

E.g. EXEC PGM=HTTPD,PARM='-X -DSSL',REGION=0M

7. Submit SOAGSTRT to bring up the SOA Gateway (Apache) server. The server is ready to be
used when you see the "XMiddLe ... is ready for requests" message in the XMIDCARD DD.

HTTPS access can be tested by checking (change host and the HTTPS port to suit your system)

https://myServer:8443/SoaGatewayStatus

For more information on configuring Apache for HTTPS see here
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9 z/VSE Environments

■ Using the Deployment Wizard to install on a z/VSE host .......................................................................... 58
■ Operating the SOA Gateway server .................................................................................................... 61

57



This section provides information about installing and running the SOA Gateway in the VSE op-
erating system environment. It covers the following topics:

Using the Deployment Wizard to install on a z/VSE host

The next step then is to install and start the SOA Gateway server. To do this, you may have to
deploy files to a remote machine. For example, you want to run your SOA Gateway Control
Center onWindows, but your SOAGateway server on z/VSE. You can use the deployment wizard
to deploy the required files to z/VSE and start your server.

■ If this is the first time you've started the Control Centre, the SOA Gateway Perspective will be
activated automatically.

If, for some reason, the SOAGateway Control Centre perspective has not started, clickWindow
-> Open Perspective -> Other and choose SOAGateway Control Center (Admin) from the list.
ClickOK

You will be asked to specify a project name or accept the default. Usually you will now simply
click the 'Continue' button, whichwill then start the 'DeploymentWizard' to guide you through
the process of defining your server within the SOA Gateway Control Center and transfer (FTP)
the installation files to the SOA Gateway Server target machine.

■ If you, for whatever reason, opt to NOT run the Deployment Wizard at that time, you can start
thewizard anytime later on by clicking the Deployment action button in the title bar of the 'SOA
Gateway Servers' view

■ The Deployment Wizard will now start
■ Select your SOA Gateway license file.
■ From the list of licensed kits, choose the z/VSE kit.
■ ClickNext
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■ The following screen allows you to either select an existing SOA Gateway server to deploy to,
or to define a new SOA Gateway server to the Control Center. This server definition will be
used for both the deployment process as well for (remote) server administration later on.

■ To define a new server:

1. Enter a 'friendly name'. This name will be used to refer to a SOA Gateway Server without
needing to enter the hostname (or IP) later on.

2. Enter the hostname or IP of the machine on which the SOA Gateway server will run. This
host/IP will be used to send the install files ( via FTP ) and will become the host/IP that you
use when issusing requests to SOA Gateway.

3. Enter the port which you would like SOA Gateway to listen for connections on.

A new Apache web server will be installed, you must ensure that the port choosen here is
available for use on the server machine.

The port entered here will utimately be the port that SOA Gateway uses to service requests.

4. Important: Once you have filled in all of the above, click 'Add Server'

5. The server will now be added to your SOA Gateway Control Centre 'Servers View' for later
use.

■ Alternatively, if an already defined server is to be used (i.e. installation files deployed to it),
check 'Deploy to existing SOA Gateway Server' and select a server from the list in the 'Existing
Server Information' section.

■ ClickNext
■ The next screen allows you to extract the z/VSE specific files to your local environment.
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■ Click the "Extract Files" button and extract the z/VSE files to your local system.
■ Using FTP, send your SOAGateway license file into the SAGLIB.ASGvvv library. This file should
be named ASG24.LIC

Important: This file must be not be translated during the transfer, therefore ensure it is
transferred in binary.

Important: In case you did not restore the SOAGateway sublibraries into a library named
SAGLIB, modify member CPLIC.P and update accordingly

Review SOAGINS3 and adjust the library/volume/extent settings. Submit this job to copy your
license file to the SOA Gateway filesystem.

■ If you wish to change the port that SOA Gateway will listen on (default: 56000) transfer the
HTTPD.CONF file from z/VSE to your PC and edit it there. The directive to change is Listen.

Important: This file must be not be translated by the FTP, therefore ensure it is transferred
in binary.

Important: In case you did not restore the SOAGateway sublibraries into a library named
SAGLIB, modify member CPHTTPD.P and update accordingly

Review SOAGINS4 and adjust the library/volume/extent settings. Submit this job to copy the
HTTPD.CONF file to the SOA Gateway filesystem.
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■ In case you did not restore the SOA Gateway sublibraries into a library named SAGLIB, modify
member CONFIG.P to point the SAG_RTS_ETC=FILE: setting from ///SAGLIB/ASG24300/ to
///<yourlib>/ASG24300/

■ Review SOAGSTRT and adjust the library/volume/extent settings.

Ensure that an Adabas (or WAL (Adabas Limited)) v8 library is included in the LIBDEF, it is
essential for the operation of the SOA Gateway server that the level of Adabas is 8.1.3.02 or
above .

If you plan to use the CICS Driver, ensure that SOA Gateway runs in OS390 emulation mode.
Add the "OS390" to the JCL, e.g.

// EXEC HTTPD,SIZE=AUTO,PARM='-DONE_PROCESS',OS390

Submit SOAGSTRT.JCL to start your SOA Gateway server.
■ In the SOA Gateway Server Deployment Wizard dialog click the Display Server Status or the
Display Status in Browser Window buttons to return the status of the server.

■ Click Finish to close the Deployment Wizard

■ Configure SOA Gateway using the SOA Gateway (Eclipse) Control Center

Operating the SOA Gateway server

■ Sizing the partition for the SOA Gateway server
■ Using a disk file for the ADARUN parameters

Sizing the partition for the SOA Gateway server

The SOA Gateway server, started with the parameters as delivered, will require a partition with
ca. 500 KB 24-bit and 36 MB 31-bit storage, plus ca. 20 KB SVA-24 and 160 KB SVA-31 storage.

To find out how much free SVA space is available on the system issue the AR command GETVIS
SVA.

The output will look like this:

AR 0015 GETVIS USAGE SVA-24 SVA-ANY SVA-24 SVA-ANY
AR 0015 AREA SIZE: 1,872K 14,728K
AR 0015 USED AREA: 1,312K 6,788K MAX. EVER USED: 1,320K 6,800K
AR 0015 FREE AREA: 560K 7,940K LARGEST FREE: 560K 7,380K
AR 0015 1I40I READY

To get more information about SVA allocation and usage run the LIBR utility function LISTDIR
SDL.
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The output will look like this:

STATUS DISPLAY SDL AND SVA DATE: 2009-07-12
TIME: 22:25

--------------------------------------------------------------------
SDL TOTAL ENTRIES : 908 (100%)

USED ENTRIES : 514 ( 57%)
FREE ENTRIES : 394 ( 43%)

SVA(24) TOTAL SPACE : 2188K (100%)
USED SPACE : 1558K ( 71%)
- PFIXED AREA: 165K ( 8%) START AT: 002C7928
FREE SPACE : 630K ( 29%)

SVA(31) TOTAL SPACE : 7620K (100%)
USED SPACE : 6685K ( 88%)
- PFIXED AREA: 680K ( 9%) START AT: 051C6F00
FREE SPACE : 935K ( 12%)

--------------------------------------------------------------------
DIRECTORY DISPLAY SDL SORTED BY PHASE NAME DATE: 2009-07-12

TIME: 22:25
--------------------------------------------------------------------
M E M B E R ORIGIN SVA/MOVE LOADED PHASE ADDRESS ENTRY POINT

NAME TYPE SYSLIB MODE INTO SVA SIZE IN SVA IN SVA
--------------------------------------------------------------------
$$BACLOS PHASE YES MOVE 31 554 04BE6C48 04BE6C48
$$BATTNA PHASE YES MOVE 31 2216 04BE6E78 04BE6E78
$$BATTNK PHASE YES MOVE 31 1104 04BE7720 04BE7720
$$BATTNR PHASE YES MOVE 31 389 04BE7B70 04BE7B70
$$BCASI3 PHASE NO MOVE 31 838 04BEF880 04BEF880
$$BCLOSE PHASE YES MOVE 31 1192 04BE7CF8 04BE7CF8
$$BCLOS2 PHASE YES MOVE 31 624 04BE81A0 04BE81A0
$$BCLOS5 PHASE YES MOVE 31 1032 04BE8410 04BE8410
$$BCLRPS PHASE YES MOVE 31 712 04BE8818 04BE8818
$$BCVSAM PHASE YES MOVE 31 768 04BE8AE0 04BE8AE0
$$BCVS02 PHASE YES MOVE 31 326 04BE8DE0 04BE8DE0
$$BDYD$$ PHASE NO MOVE 31 104 04BEFBC8 04BEFBC8
...
...
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Using a disk file for the ADARUN parameters

The SOA Gateway start job, SOAGSTRT.JCL, as distributed uses inline ADARUN parameters.

It may prove advantageous to put these parameters on a disk file instead, the following is sample
JCL to do this:

* $$ JOB JNM=DITTOCS,CLASS=0,DISP=D
* $$ LST CLASS=A,DISP=D
// JOB DITTIOCS CARD TO SEQUENTIAL DISK FILE
// UPSI 1
// DLBL CARD,'SOAGATE.ADARUN.PARAMETERS',0,SD
// EXTENT SYS010,vvvvvv,1,0,ssss,1
// ASSGN SYS010,DISK,VOL=vvvvvv,SHR
// EXEC DITTO
$$DITTO CS FILEOUT=CARD,RECFMOUT=F,BLKSIZE=80
ADARUN PROGRAM=RENTUSER
ADARUN SVC=<your_ADABAS_SVC_number>
ADARUN DATABASE=<your_ADABAS_dbid>
/*
/&
* $$ EOJ

After having created the disk file replace the inline ADARUNparameters in SOAGSTRT.JCLwith
the appropriate sequence of DLBL CARD, EXTENT and ASSGN statements.
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10 Uninstallation Guide

■ Uninstall SOA Gateway Server - Linux, z/Linux, AIX and Solaris ............................................................... 66
■ Uninstall SOA Gateway Server - Windows ............................................................................................ 66
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Uninstall SOA Gateway Server - Linux, z/Linux, AIX and Solaris

1. Ensure the SOA Gateway server is not running.

Change to the <SERVER_install_dir>/apache2/bindirectory, replacing <SERVER_install_dir>with
the location where you installed the SOA Gateway server.

Run the command ./apachectl stop

2. The <SERVER_install_dir> can now be removed. Use the command rm -rf
<SERVER_install_dir>.

Important: Once you run this rm command, all files anddirectories in <SERVER_install_dir>
will be permanently deleted.

3. This completes the uninstall process.

Example:

# cd /usr/local/server/apache2/bin
# ./apachectl stop
# cd /usr/local
# rm -rf server
#

Uninstall SOA Gateway Server - Windows

1. Start the Windows Control Center by clicking Start -> Control Panel

2. Select theAdd or Remove Programs or Programs and Features (depending on your version of
Windows)

3. Select SOA Gateway 2.6.1 and click Change/Remove or Uninstall

4. Select Remove radio button and clickNext

5. ClickOK to uninstall SOA Gateway
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11 Copying or upgrading server configurations

■ Copy configuration with drag-and-drop ................................................................................................ 68
■ Upgrading using the Copy Wizard ....................................................................................................... 68

67



After having created a new environment, you may want or need to copy the existing service
definitions to your new server.

This is possible with either

■ Drag-and-Drop
■ The Copy Wizard

Note: When copying between SOA Gateway servers at the different software levels, the
copy operation will compensate for differences in the structure of the server configration
etc., should this not be fully possible for some reason, error messages will indicate the
reason(s).

The following scenarios are possible when copying configuration elements

No problems to be expectedCopy to a server at the same level

New features may have been introduced, default values may
be used for new elements.

Copy to a higher level server ("upgrade")

Loss of a certain amount of control information possible due
to elements not known by the down-level server

Copy to a lower level server ("downgrade")

Copy configuration with drag-and-drop

See here for more information on this feature.

Upgrading using the Copy Wizard

See here for more information on this feature.
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